
 

 

 

 

 

 

 



Definition 

A chemical process simulator 

that is used to mathematically 

model chemical process, from 

operations to full chemical 

plants & refiniries. 

 

 

 

 

 

 

 



Function 

HYSYS is able to perform many 

of the core calculations of 

chemical engineering, including 

those concerned with mass & 

energy balance, VLE, heat & 

mass transfer, chemical 

kinetics, fractionation, and 

pressure drop.  



Speciality 

The Most requested process 

simulator that has been trusted 

for over 35 years.  

Experience the latest 

innovations in process 

simulation and achieve up to 

98% accuracy on the V11. 

 In addition, it can be used to 

see the antoine value and 

determine physical properties 

for unknown components.  



My Purpose 

I created this book in order to 

maximize the chemical 

engineering field in an era that 

has already industrialized 4.0 

or even more, where everything 

is completely using digitalized.  

On the other hand, my hope is 

that students can apply more 

deeply about HYSYS because it 

is very useful when they have 

graduated. As well as being 

able to evaluate manual 

calculations that are compared 

with the HYSYS calculation. 

-Present for My beloved Mom-  



Working Instruction 

➢ Determine the right tool to solve 

the problem: 

 Manual calculation, then 

 Simulator HYSYS compare 

➢ How to used HYSYS: 

 Determine the component & 

thermodynamic model / Fluid 

Package. 

 Specify the process:  

➢ Set the feed properties 

➢ Decide the unit operations 

 Determine the connectivity of 

stream for each unit operations 

 Fix the parameter operations 

 Run and check the result 



Manage the unit value 

1. Click Tools on the Tab menu  

2. Click Preferences 

3. Click bottom Variable  

4. Any option is available,  

5. When you want to set the unit, 

as following below: 

Clone > Unit Set Name to 

rename > Click symbol Az > 

Click Unit with blue colour > 

set the unit you want.    
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Basic 

1. Phase 

A mixture amounts of 100 

lbmole/hr with composition (in 

% mole) Propane 69%, n-

Butane 21% and n-Pentane 

10%. Determine the phase of the 

mixture at 140F and 200 psia, Is 

it only 1 phase (Liquid or 

Vapor) or two phases?  

Clue: Peng Robinson. 

 

Step: 

➢ File > New > Case > Add > 

Input 3 components above   

➢ Fluid Packages  

➢ Enter Simulation 

➢ Input blue stream in the Object 

Palette 



➢ Input the condition: 

T = 150 F,  

P = 200 psia &  

Molar Flow = 100 lbmole/hr. 

➢ Input the compositions: 

Propane : 0.69 

n-Butane : 0.21 

n-Pentane : 0.10 

*The unit: Mole Fractions 

 

Conclusion: 

Value of Phase: 

0  = total liquid  

1  = total vapor  

0 – 1  = mixture. 

 



2. Boiling & Dew Point 

Mixture with amount of 100 

lbmole/hr and compositions (% 

mole) Propane 69%, n-Butane 

21% dan n-Pentane 10%. 

Determine the boiling / dew 

point from the mixture at 200 

psia.  

Step: 

➢ Do as the number 1 till insert the 

compositions value 

➢ Set the Vapour / Phase Fraction 

1 untuk boiling 

0 untuk dew 

➢ Input P  = 200 psia  

➢ Mass flow  = 100 lbmole/hr 

 

 

 



Conclusion: 

Dew Point =  54.70 oC  

Boiling Point  =  74.59  oC 

 

 
 

 

 

 

 

 



3. CGR dan WGR  

Determine Condensate Gas 

Ratio (CGR) and Water Gas 

Ratio (WGR) on Sbbl/MSCF 

unit at 21 bar and 50 oC. 

Clue: SRK (Soave Redlich Kwong) 

Components, as below: 

 



*Note 

 Sbbl        = Standard barrels 

 MMSCF = 1 Mill std ft3 

 

Step: 

➢ Input components  

➢ Click Hypothetical for the 

component from C6 till C11 

➢ Click Hypo Manager then add 

and input the name 

➢ Set Hydrocarbon as component 

class.  

➢ Add Hypo 6x then insert name, 

MW & Density.  

➢ Click Estimation Unknown 

Props 

➢ Blue means our input and red 

means the calculated result.  

➢ Close 2x then add group/hypo.  



➢ Input the Fluid Package. 

➢ Enter simulation 

➢ Insert blue stream and input the 

compositions 

➢ Insert 3 Phase Separator with 

names of Inlet (Feed), Vapour 

(Vapour), Light (Condensate) 

and Heavy Liquid (Water). 

➢ Set the Molar Flow Vapour  = 1 

MMSCFD 

➢ Click show tabel on each stream 

& choice variabel Temperature, 

Pressure, Molar Flow dan Mass 

Flow. 

 

 

 

 

 



➢ The result we can see that: 

.... Sbbl/day @ 1 MMSCFD. 

 

 

 

 



4. Petroleum Fraction 

Determine the phase & mass 

flow of 100000 barrel/day crude 

oil at 450 F & 75 psia within 

below: 

Clue: PR 

 

 

 

 



Step: 

➢ Input the components & FP 

➢ Click Oil Manager then set 

basis-1 & select Enter Oil 

Environment 

➢ Click Add, then bulk into Used, 

fill the Standard Density with 

54.82 lb/cuft, type of viscosity = 

Dynamic, Viscosity 1st Temp. 

100 F & 2nd 210 F. 

➢ Change Assay Data Type into 

TBP then click Edit Assay also 

input the data above & OK. 

➢ Click Light Ends  changes to 

Ignore into input composition & 

on the Input Data pick Light 

Ends & fill the data above. 

➢ Click Calculate then Close. 



➢ Click Cut/Blend then Add & 

Add again last is close. 

➢ Click Instal Oil then set Crude 

Oil as Stream Name  

➢ Click Return to Basis 

Environment 

➢ Then click Return to 

Simulation Environment 

➢ Save As Crude Oil file name if 

want to use it again 

➢ Input blue Stream & check the 

composition also input the 

condition operation as above. 

 



Conclusion: 

1. Fase &  

2. Mass flow is reported 

 

  



Unit Operation 

1. Valve 

Liquid is flashing with valve at 

1 atm then insert to separator.  

 

Compositions: 

Metana : 50 lbmol/hr 

Etana  : 70 lbmol/hr 

Propana : 60 lbmol/hr 

Determine molar flow & 

compositions at 100 psia. 

 

Step: 

➢ File > New > Case 

➢ Component > Add > Input the 

components 

➢ FP > Add > PR 

➢ Enter Simulation 



➢ Input the blue stream & rename 

“Feed” > fill the composition 

(basis Mole Flows) 

➢ Condition: 

Vap Phase 0 >  

P 100 psia >  

Molar flow 180 lbmol/hr 

➢ Insert Valve > Inlet (Feed) > 

Outlet (VLV Out)  

➢ Worksheet > VLV Out P 14.70 

psia > Pressure drop on ∆P will 

be shown 

➢ Insert Separator > Inlet (VLV 

Out) > Vapour Outlet (Vap) > 

Liquid Outlet (Liq) 

➢ To show the tabel > right click 

on the stream then show table. 

 

 



Result: 

 

 



2. 3-Phase Separator 

How much the output of Gas, 

Oil and water when Input 

Stream 25.000 BPD at 21 bara 

& 50 oC. Compositions: 

 

Also determine WGR & CGR! 

 

 

 



Step: 

➢ Input H2O till n-C5  

➢ Component > hypothectical > 

input MW & density > estimate 

unknown 

➢ FP > SRK (Oil & Gas) 

➢ Insert the blue Stream & fill the 

condition operation 

➢ Setting the composition (Basis 

Mole Fractions) 

➢ Insert 3 phase separator > light 

liquid (Oil), Heavy (Water). 

➢ Result can be seen when the 

table show on the stream. 

➢ Determine WGR&CGR 

➢ Delete molar flow in Stream 1  

➢ Input Molar flow for gas = 1 

MMSCFD 

 



Result: 

WGR : 1 : 50.85 

CGR : 1 : 18.91 

 
 



3. Heat Exchanger 

How much the calor generated 

if benzene at 400 kpa & 90 oC 

will be cooled to 40 oC with 

Heat Exchanger by water at 25 
oC 400 kpa & the flow is 1000 

kg/hr benzene while 10000 

kg/hr of water. And also:  

a. Temperature output with 1000 

kj/ch heat transfer ? 

b. Mass flow if using water 30 oC? 

Step: 

➢ Input components and so the FP 

➢ Insert 2 blue stream (rename 

with benzene dan water) 

➢ 1st Benzene at 90 oC 400 kpa 

and mass flow 100 kg/hr with 

composition benzene = 1 



➢ 2nd Water at 25 oC 400 kpa and 

mass flow 10000 kg/hr with 

composition water = 1 

➢ Insert HE,  

Tube in named Benzene & Tube 

out = Benzene out. Shell in = 

Water & Shell out : Water out 

➢ Click parameter: assumed dP 

Shell : 2 psig & tube : 5 psig 

➢ Click worksheet then input 

Temp. benzene out : 40 oC 

➢ Click Rating then look at overal 

UA (It shown kj/Ch alias kj per 
oC required) 

➢ To know temp. benzene out 

when UA 1000 kj/Ch is:  delete 

first temp. benzene out then 

input UA = 1000 Kj/Ch. 



➢ To know mass flow water out of 

30 oC. delete first heat flow then 

input benzene out temp. 40 oC & 

delete mass flow water then 

input temp. water out 30 oC. 

Mass flow will be shown & less 

also affect to capability of pump 

 

Result: 

 



4. Pump (for liquid) 

How much the Power required 

to pump Metanol with mass 

flow of 5000 kg/h at 100 kpa 

into 6 barg. Also how much the 

temperature increasing if the 

Power is become 6000 kJ/hr? 

Step: 

➢ Input the components & FP is 

using PR. 

➢ Insert blue Stream (rename 

Metanol Suction) with T = 25 
oC, P = 100 kpa & mass flow 

5000 kg/hr. Composition 

metanol 0.86 & water 0.14 

➢ Insert pump inlet as Metanol 

Suction & outlet as Metanol 

discharge.  



➢ Input P out 6 barg & rename 

energy as Energy-Pump. Then, 

heat flow will be shown on 

Stream Energy & so the Power.  

*Kj/h  / 3600 = kW 

➢ To detail can show it in show 

table in the stream then set as 

you want (variable). 

➢ To know the temperature 

increase. Delete first P out & 

input heat flow 6000 kJ/hr. 

Result:  

 



5. Compressor 

How much the Power required 

to compress 73% Methane 27% 

Ethane at 33 oC with mass flow 

20 MMSCFD & initial pressure 

2 barg to be 16 barg. The system 

is adiabatic & efficiency = 86%. 

Also determine the temperature 

increase if Power given 1500 

KW? 

Step: 

➢ Input components & FP = PR. 

➢ Insert blue Stream & rename as 

GAS Suction with T = 33 oC & 

P = 3 barg also 20 MMSCFD 

molar Flow. 

➢ Input the composition as above 

➢ Insert Compressor, Inlet as GAS 

Suction, Outlet as Gas 



Discharge & energy name with 

E-100. 

➢ In the Worksheet tab fill P = 16 

barg. 

➢ Power can be seen on E-100 

➢ Then delete P out also fill 1500 

kW in Heat Flow red stream 

then increasing temperature & 

pressure can be seen. 

 

Result: 

 
 



6. Turbine  

How much the power generated 

if we have 1000 kg/jam steam at 

500 oC 6000 kpa & efficiency = 

78%. If  the pressure output 200 

kpa how much kg/h water 

required to produce 1 MW 

power? 

Step: 

➢ Input Component then FP is PR 

PR. 

➢ Insert turbin & fill inlet name 1 

then outlet name 2 & energy 

named E-100 

➢ Input condition as the task 

above & the composition is 1. 

➢ To know the result can be seen 

in the stream energy (heat flow) 



➢ To see the power can see in the 

table show. 

➢ To know the mass flow delete 

first then input energy = 1 MW 

& can be seen the mass flow 

water. 

 

Result: 

 
 

 

 



7. Splitter  

Separate i-Butane from other  

components at 145 psia top and 

bottom 153.5 psia. Also i-

Butane 5% still in the bottom & 

n-butane 5% still on top. Use 

GRAYSON-STREED as FP. 

Condition operation: 

 

 

 



Step: 

➢ Input the components & FP 

➢ Insert the blue & fill the 

composition so the condition  

operation.  

➢ Insert the Splitter & pick inlet, 

outlet & energy stream.  

➢ Input split on top:  

Propane  : 1 

i-Butane : 0.95 

n-Butane : 0.05 

i-Pentane : 0 

➢ On the Parameter: 

Vapour Fraction : Top        = 1 

       Bottom   = 0 

Pressure as description 

 

 

 



➢ Show Tabel on each Stream  

 
 

 

 

 

 

 



8. Reactor conversion (CH4 Combustion) 

Composition: 

Methane : 0.01 lbmole/hr 

Oxygen : 0.02 lbmol/hr 

Condition Operation: 

25 oC & 0 barg.  

What is the fraction of 

component & temperature out 

after reaction ?  

 

Step: 

➢ Input components of CH4, O2, 

H2O dan CO2. Use PR as FP. 

➢ Click Reactions  

➢ Add, click Conversion & input 

the raw material then product 

with setting Coeffisien: 

CH4 : -1 

O2 : -2 



CO2 : 1 

H2O : 2 

➢ Basis, pick Methane as Base 

Component & Vapour Phase 

in Rxn Phase also Co = 100. 

Then close. 

➢ Clock Reaction Set then delete 

Global Set & Add Set. Then 

active checklist in Active List & 

then Add to FP.  

➢ Enter simulation Environment. 

➢ Insert blue Stream & name 

Methane also input the 

composition as 1. 

➢ Condition at 25 oC 0 barg & 

molar flow 0.01 kgmole/hr. 

➢ Insert blue Stream & rename as 

Oxygen then fill with 1 the 

composition 1. 



➢ Then fill the same condition 

operation but molar flow 0.02 

kgmole/hr. 

➢ Insert Reaktor Konversi 

➢ Inlet (Methane & Oksigen), 

Vapour Outlet (Gas), Liquid 

Outlet (Liquid). 

➢ Pick Reactions in the reactor 

then click Reaction set become 

Set-1. 

➢ Show tabel of each stream for 

the variabel Temperature, 

Pressure, composition of each 

Component & Molar Flow. 

Then will be seen T, P, m & 

Component of each Stream. 



 



9. Distilattion Column 
Pure Ammonia produce from mix 

Ammonia-Acetone-Water with 16 

Stages include reboiler dan 

condenser total. Feed on Stage 13 

& side draw on stage 5.  

Data as below: 

 

 

 



Step: 

➢ Input the component above & 

NRTL as FP 

➢ Insert blue Stream also the 

composition.  

➢ Fill the condition temperature 

473 K & Pressure 1583 kPa.  

➢ Insert Distillation Column then 

click Total Condenser and 

named Q Condenser on the 

Energy Condenser, Q Reboiler 

on the Energy Reboiler & Feed 

as Inlet, Overhead as Ovhd 

Outlet, Bottom as Bottom 

Outlet, also Side Draw on 

Optional Side Draw, & 13 as 

Inlet Stage & 16 total Stage. 

Then, Next 



➢ Input 290 psia on the Condenser 

pressure & 10 Psi on the 

Condenser Pressure Drop also 

300 psia on the Reboiler 

Pressure. Change dP reboiler to 

1.5 kPa. Then, Next 2x & Done. 

Click Specs & delete all of the 

Variabel.  

➢ DOF = 3 then have to input 3 

Variabel required. Add 

➢ Pick Column Draw Rate rename 

as OverheadRate & choice 

Overhead@COL1 on Draw & 

input 3702 at Spec Value. 

➢ Click Column Draw Rate then 

change name to Side Draw Rate 

& pick Side Draw@COL1 in 

draw also input 18 kgmole/h in 

Spec Value.  



➢ The last pick Column Reflux 

Ratio & Condenser in Stage so 

input 0.6753. Then close. 

➢ As we can see that DOF = 0 and 

click Run  

➢ Then click Parameter to see 

Pressure, Temperature & flow 

of each stage and tray. 

➢ To see the detail distillation 

column. Column Environment. 

➢ Result: 

 



Logical Operations 

1. Set  

To fix the value from process 

variabel which is spesific with 

other similar variabel (example: 

Temperature from 2 Stream).  

2. Adjust  

To variate 1 value of variable 

independent to comply with any 

spesification required (Variabel 

Dependen). It can be use for 

different variabel / similar. Also 

can be used for trial iteration & 

error for the automatic. 

3. Example of SET & ADJUST: 

1. Well with composition of (A & 

B) ratio 80:20 at 120 oC 40 barg. 



The gas flow rate required from 

well = 300 MMSCFD with 

WGR 20 Sbbl/MMSCF, gas 

flow rate is not including the 

liquid. 

2. Flow of well split to 2 stream 

which is the one has Std. Gas 

Flow (MMSCFD) = 100. FP = 

PR. 

 

 

 

 

 

 

 

 

 

 



Data composition: 

 
 

 

 

 

 



Note: 

Std. Gas Flow can’t be input 

directly as Molar Flow 

(MMSCFD). 

Step: 

➢ Input the composition then in to 

tab Hypothetical for C11 

➢ Click Hypo Manager then add 

and rename the group 

➢ Click Hydrocarbon as the class.  

➢ Add Hypo 1x then input 

Name  : C11  

NBP[C] : 300 

MW  : 200 

Density  : 800 kg/m3 

➢ Click Estimate Unknown Props 

➢ Input into Component by Add 

hypo 

➢ Use PR as FP. 



➢ Enter Simulation Environment 

➢ Insert blue Stream (A) & fill the 

composition. Then, set the 

condition 120 oC & 40 barg. 

➢ Insert the blue Stream biru (B) 

& composition as the data also 

condition same as A. 

➢ Insert blue Stream (Water) & 

Composition 1 with same 

condition of A. 

➢ Insert Mixer & inlet A, B & 

Water also outlet (Pre Heater) 

➢ Insert Heater with inlet Pre 

Heater also Energy (Q Heater) 

& Outlet (Well) with dP 0 psi so 

Temp. Well  120 oC. 

➢ It can be seen that all Stream is 

not OK (Still light blue) due to 

not have the flow. 



Tips: 

1. Flow Stream A get from 

Adjust to get 300 

MMSCFD in Stream Well. 

2. Flow Stream B get from 

SET installed between 

Stream A dan B.  

3. Stream water get from 

Adjust to reach 6000 

BWPD on the Stream Well. 

 

Continue Step: 

➢ Insert 2 Adjust & 1 Set. 

➢ SET: 

Target : Std Ideal Liq Vol B 

Object : Stream A 

Multi : 0.25 

Offset : 0 barrel/day 

➢ ADJUST-1 : 



Adjusted Variabel 

Object : Mass Flow A 

Target Variabel 

Object : Phase Std Gas Flow 

(Vapour Phase) Well 

Target Value  : 300 MMSCFD 

Method : Secant 

Tolerance : 0.001 

Step Size : 9000 kg/h 

Minimum : 0 

Maksimum : 1 Billion 

Max Iterasi : 1 Million  

➢ ADJUST-2: 

Adjusted Variabel 

Object : Mass Flow Air 

Target Variabel 

Object  : Phase Liq Vol 

Flow (Aqueous Phase) Well  

Target Value  :6000 barrel/day 



Method : Secant 

Tolerance : 0.001 

Step Size : 9000 kg/h 

Minimum : 0 

Maksimum : 1 Billion 

Max Iterasi : 1 Million  

➢ Input flow on Stream A and 

Water then the value will differ 

to be the target. 

➢ Insert the Tee with Inlet (Well) 

then outlet (to Test Separator) & 

(to Production Manifold) then 

stream still in light blue. 

➢ Insert Adjust-3 

Adjusted Variabel 

Object : Flow Ratio [Flow 

Ratio_1) Tee 

Target Variabel 



Object  : Phase Std Gas 

Flow [Vapour Phase] to Test 

Separator  

Target Value  : 100 MMSCFD 

Method : Secant 

Tolerance : 0.01 

Step Size : 0.01 

Minimum : 0 

Maksimum : 1  

Max Iterasi : 1 Billion  

➢ Due to is not OK 

➢ Open TEE then Parameter & 

click Flow Ratio set into 0.1 for 

to test.  

➢ Double click on Stream to Test 

Separator then see Properties & 

also Std Gas Flow become 100 

MMSCFD.  

 



Result: 

 
 

 

 

 

 

 

 

 



4. Recycle  

A plant wants to increase 

pressure of Gas with Gas 

Compression Plant. Gas 

separate from the liquid with 1 

Separator with asumption dP 0 

& eficiency compressor 72.5% 

with increasing pressure into 

1000 psia. Then decrease the 

temperature with cooler dP 10 

psi. Temperature set till have 

composition of 80% methane 

(mole fraction). Gas outlet then 

separate with Separator 2 dP 0.  

Data, as below: 



 

Question: 

1. Which is located the recycle? 

2. T out cooler? 

3. Flow rate (lbmole/hr) gas 

product? 

4. Flow rate (lbmole/hr) output 

recycle? 

 

 



Step: 

➢ Input the component above & 

use PR as FP. 

➢ Insert blue Stream & input the 

composition also the condition. 

➢ Insert Separator 1 & inlet (Inlet 

Gas), Vapour Outlet (Vap) & 

Liquid Outlet (Liq). Then close. 

➢ Insert Compressor & inlet 

(Vap), Energy (Q Comp) also 

Outlet (Feed Cooler). 

➢ Set the efficiency in Parameter 

(72.5%), input P out 1000 psia. 

➢ Insert Cooler & inlet (Feed 

Cooler), Energy (Q Cooler) & 

Outlet (Feed Sep 2). Then input 

dP 10 psi also feed Temperature 

Feed 50 oF in tab Worksheet. 



➢ Insert separator 2 & inlet (Feed 

Sep 2), Vapour Outlet (Gas 

Hasil) and Liquid Outlet 

(Recycle). 

➢ Insert blue Stream Biru and 

named Liq Recy then click 

Define from Other Streams then 

pick Recyle in the Available 

Stream.  

➢ Double click on the Separator 1 

then inlet add Liq Recy. 

➢ Insert Recycle, inlet (Recycle), 

Outlet (Liq Recy). Because is 

not Converged, then 

➢ Insert Adjust & set:  

Adjusted Variabel: 

Object    : Feed Sep 2 

Variabel : Temperature 

Target Variabel: 



Object      : Gas Hasil 

Variabel : Master Comp Mole 

Frac (Methane) 

Target Value : 0.8  

Tolerance : 1e-3 

Step Size : 10 F 

Minimum : 1 F 

Maximum : 1000 F 

Iterasi  : 1000 

➢ Result. 

 



5. Spreadsheet  

It is used to calculate on the 

variable process with the 

formula inside. Such as excel 

but version HYSYS also can be 

used for complex mathematical 

formula & Boolean Logical. 

Spreadsheet also has full access 

to all of variable process so the 

logical unit.  

Example: 

Optimization Crude Oil in to 

Plant Design No. 4 with setting 

the pressure in the Separator 

because if pressure increases the 

liquid production also is 

increase. Margin called as the 

difference between decreasing 

of liquid again minus the utility 



cost of reboiler & condenser can 

be calculated in $/day.   

Cost Factors: 

1. Recovered liquid = $28/bbl 

2. Electric condenser= $0.04/kwhr 

3. Gas for reboiler = $2.5/MMBtu 

4. Power Factor = 3.412 Btu/kwhr 

 

Step: 

➢ Insert 4 Set 

➢ Setting the Set 3: 

Target Variabel: 

Pressure Stab Vapour 

Source: 

Gas 

Multiplier : 1 

Offset  : -10 psi 

➢ Also for Set 4: 

Target Variabel: 



Pressure Bottom 

Source:  

Gas 

Multiplier : 1 

➢ Then  5: 

Target Variabel: 

Pressure Oil 

Source: 

Oil & Water 

Multiplier : 1 

➢ Last is Set 6: 

Target Variabel: 

Pressure Water 

Source: 

Oil & Water 

Multiplier : 1 

➢ Insert Spreadsheet then named 

with Economics 



➢ Click Add Import then pick Cell 

A1, Object (Pump Out), 

Variabel (Std Ideal Liq Vol 

Flow) 

➢ Click Add Import again on A2, 

Q Condenser and Heat Flow 

➢ Click Add Import for A3, Q 

Reboiler and Heat Flow 

➢ Then click on tab Spreadsheet & 

input information as below: 

 

Revenue from 

Volume from 

Cost of 

Cost of 



Result: 

 



➢ Input Databook then Insert and 

pick Pressure LP Crude. 

➢ Insert again Mass Flow Stab 

Feed, Stab Vapor & Stab 

Bottom. 

➢ Insert Heat Flow Q Conderser & 

Q Reboiler. 

➢ Insert Std Ideal Liq Vol Flow 

Pump Out 

➢ Last Insert B12, B13, B14 & 

B17 Economics.  

➢ Click Case Studies & pick 

Pressure LP Crude Ind and 

beside that Dep. then click View 

➢ Pick Independent Variables 

Setup & input Low 275, High 

375 & Step Size 5. Then Start, 

➢ To know the result click Result 

and will be an option of Graph. 



➢ Click Setup to choose variable 

you want to see. 

➢ Checklist only B17 then click 

Result. 

6. Balance  

It used to provide Heat & 

Material Balance.  There are 6 

types of Balance Operation. To 

get Solve, only 1 variable shall 

to input between temperature / 

pressure output (neither).  

Example: 

Create 1. Balance Heat and 

Material Balance  

Compositions: 

Methanol  : 40% 

Acetic Acid : 40 % 

Water  : 10% 



M-Acetate : 10% 

Condition Operation : 

Tin          : 164.6 F  

Tout         : 86 F 

Pin         : 100 psig 

Molar Flow : 0.9107 MMSCFD 

➢ Input component and FP using 

PR 

➢ Insert 2 blue Stream Biru then 

fill the condition & 

composition.  

➢ Insert Balance & use 

Component Mole & Heat Flow 

Balance Type.  

 

 



➢ We can see that Heat Flow & 

Mass & Molar Flow will be 

similar in the input & output. 

 

 

 

 

 



Plant Design 

1. Crude Stabilizer Plant 

Stream of Well is choked down 

to 300 psia then goes to 

separator & Oil from Separator 

flows to stabilization tower after 

heated by 250 oF. Stabilizer has 

T condenser 120 F & Reboiler 

100 F. Product tower bottom till 

150 F & pump till 1000 psia. 

Then result of top compressed 

into 1000 psia. Pressure drop in 

HE = 5 psi for each section & 10 

for Stabilizer. Simulate it!  

 

 

 



Composition well: 

 

Step: 

➢ Input the component 

➢ Click tab Hypothetical for C7F 

sampai C18F 



➢ Click Hypo Manager then add 

also name the group 

➢ Pick Hydrocarbon as the 

component class.  

➢ Add Hypo 5x then input Name, 

MW, Density.  

➢ Click Estimation Unknown 

Props 

➢ Blue is our input & red is result 

➢ Close 2x then add group/hypo 

one on one. FP uses PR  

➢ Enter Simulation 

➢ Insert blue Stream and input the 

Composition at 150 oF & 800 

psia with flow rate 10000 

lbmol/hr. Then close 

➢ Insert Valve (Name it) Choke 

Valve & fill Inlet (Crude) So 

Outlet (LP Crude). 



➢ Pressure drop = 500 psi then 

close. 

➢ Insert 3-Phase Separator with 

Inlet (LP Crude), Vapour (Gas) 

Light Liquid (Oil) & Heavy 

Liquid (Water). Then close. 

➢ Insert Heater and named with 

(Preheat Exchanger) then inlet = 

Oil, Energy = Q heater & Outlet 

Stab Feed.  

➢ Parameter with dP 5 psi & Tout 

250 F. Then close. 

➢ Insert Splitter & named with 

Stabilizer also Inlet Stab Feed, 

Top Outlet = Stab Vapour & 

bottom = Stab Bottom so 

Energy = Q Stab. 

➢ Splits: 

C1  : 1 



C2  : 1 

C3  : 0.95 

C4  : 0.05 

H2O  : 1 

Besides that = 0. 

➢ Parameter: 

T Vapour : 120 F 

P Vapor : 290 psia 

Fraction Bot : 0 

P bottom : 300 psia 

Then close. 

➢ Insert Separator with inlet (Stab 

Vapour), Vapour Outlet 

(Vapor) & Liquid Outlet 

(Liquid). Then close. 

➢ Insert Compressor with inlet 

Vapour, Energy Q Compressor 

dan Outlet (Tower Vapour) 



➢ Parameter then click Adiabatic 

Effisiensi 72% at P Tower 

Vapour 1000 psia. Then Close. 

➢ Delete Pre Heat Exchanger also 

the Q Heater due to get Stream 

Bottom from Stabilizer to heat 

Oil that will be feed to 

stabilizer.  

➢ Insert HE with Tube inlet (Oil), 

tube outlet (Stab Feed), shell 

inlet (Bottom) & shell outlet 

(Cooler Feed). 

➢ Parameter input dP 5 psi for 

tube & shell also change HE 

model to Weighted. Then close. 

➢ Insert Cooler with inlet (Cooler 

Feed), Energy (Q Cooler) & 

Outlet (Pump Feed). 



➢ Parameter & dP 10 psi at 150 F 

then named temperature out. 

Click close. 

➢ Insert Pump with inlet (Pump 

Feed), outlet (Pump Out) & 

Energy (Q Pump). 

➢ Parameter & dP 715 psi with 

adiabatic efficiency 76.5%. 

Then close. 

 

 

 

 

 

 

 

 

 

 



Result:  

 



2. Continue of Case 1 

From case 1 want to separator 

operated as adiabatic at 300 psia 

& hydrocarbon liquid contain 

0.1% (molar) water. Change 

Separator 3 phase into 2 phase 

then Splitter. To get 

spesification of water content in 

the water on the feed stabilizer. 

Use adjusts to variety water 

fraction in the oil stream. Use 

Set to control the condition of 

product flow from dari Splitter 

at 300 psia & use set to specified 

temperature output because 

have to same with flow of oil + 

water. 

 

 



Step: 

➢ Use case 1 

➢ Delete 3-phase Separator then 

insert 2-Phase Separator & 

Splitter. 

➢ Separator named then input LP 

Crude as Inlet & Gas as Vapour 

Outlet as Oil & Water on the  

Liquid Outlet. Then close. 

➢ Splitter named with Separator 2 

then input Stream Oil & Water 

as Inlet & Oil on Overhead 

Outlet also click Water on 

Bottom Outlet. Input Q-Sep 2.  

➢ Input 300 psia on Pressure Oil & 

Water in Parameter. Then close. 

➢ Insert Adjust & 2 Set  

➢ Set 1: 

Target Variabel: 



Temperature Oil 

Source: 

Oil & Water 

Multiplier : 1 

Offset  : 0 F 

➢ Set 2: 

Target Variabel: 

Temperature Water 

Source: 

Oil & Water 

Multiplier : 1 

Offset  : 0 F 

➢ Adjust: 

Adjust Variabel: 

Object     : Separator 2 

Variabel : Overhead Fraction 

Water 

Target Variabel: 

Object    : Oil 



Variabel : Master Comp Mole 

Frac Water 

Target Value: 0.001 

➢ Lalu Parameter: 

Toleransi : 1e-6 

Step Size : 1e-2 

Minimum : 0 

Maximum : 1 

Iterasi  : 1e6 

Then close. 

➢ Splitter edit Splittere & input 1 

on the all of components except 

H2O. 

➢ From Worksheet composition 

of Oil will be shown H2O = 

0.001. 

 

 



Result: 

  



3. Continue Case 2 

Model required of distillation 

column has 8 stages theoretic 

(except condenser & reboiler) at 

P kondenser 290 psia and dP 10 

psi. Temperature bottom   360 
oF, feed from stage 4 with same 

temperature feed 250 oF & 

temperature condenser 120 oF. 

Product liquid bottom has 25 

psia.  

Step: 

➢ Continue Case 2 then insert 

Distillation Column 

➢ Delete Separator 1 & Stabilizer 

also the Stream Vapour, Liquid 

& Qstab 

➢ On the Distillation Column, 

pick Full Reflux & named with 



(Stabilizer), Q-Condenser for 

Condenser Energy & Q-

Reboiler for Reboiler Energy 

then Stab Vapour for Ovhd , 

Bottom for Bottoms & input 

Stab Feed on Inlet Stream then 

pick stage 4 for the feed & 8 for 

total Stages. Then Next. 

➢ It will shown 290 psia above, 0 

psi middle & 300 psia bottom. 

Then Next 2x. 

➢ Click Done. 

➢ Click Specs 

➢ Delete all variabel in Column 

Specification by click Tab 

Delete for each Variabel then 

DOF = 2. It means we have to 

add 2 Variabel. Then Add 



➢ Click Column Temperature then 

Add Specs, input Condensor as 

Stage at 120 oF in Spec Value. 

Then close.  

➢ DOF = 1,  

➢ Pick Column Vapour Pressure 

Spec then pick Reboiler Stage at 

25 psia in Spec Value. Then 

close. 

➢ Click Run and Converged. 

Close, in the parameter field can 

be seen the result. 

➢ Click Column Environment to 

see the detail 

➢ Click the erlenmeyer to back to 

Environment / CTRL + T 

➢ Click Parent Environment & 

will be back to Home. 



➢ Insert Stream Stab Vapour into 

inlet Compressor & Outlet as 

Tower Vapour also Energy (Q 

Compressor). Then close 

Result: 

  



4. Multi Stage Separation 

Separate feed with 1050 psia & 

135 oF to gas dan liquid. 3 stage 

separator of pressure 260, 90 

dan 20 psia to stabilize crude. 

Heater is used before 2nd stage 

to fulfill spec crude vapor 

pressure 15 psia at 100 F. Gas in 

to 3rd stage compresor 

centrifugal at 750 psia output. 

Output of each compressor want 

to 100 F and liquid recycled to 1 

of stages. Liquid stage 1 

recycled to low pressure 

separator, but 2nd 3rd liquid 

scrubber recycled to intermediet 

pressure separator. Assumed dP 

5 psi on each cooler & heater 



with adiabatic compresor = 

0.72.  

Data, as below: 

 

Step: 

➢ Input component & click 

hypothetical. FP = PR. 



➢ Insert blue stream & input the 

composition. 

➢ Insert separator with name Flash 

1, Inlet (Feed), Vapour Outlet 

(Vap F1) & Liquid Outlet (Liq 

F1). 

➢ Set parameter & input dP 790 

psi. 

➢ Insert Heater & inlet (Liq F1), 

Energy (Q Heater) also Outlet 

(Outlet Heater) 

➢ Set parameter with dP 5 psi T 

outlet 200 oF. 

➢ Insert Mixer then named Mixer 

1 & inlet (Outlet Heater) then 

Outlet (Feed F2).  

➢ Insert Separator with name 

Flash 2, inlet (Feed F2), Vapour 



Outlet (Vap F2), & Liquid 

Outlet (Liq F2). 

➢ Set parameter & dP 175 psi. 

➢ Insert Mixer named Mixer 2 

then inlet (Liq F2) & Outlet 

(Feed F3). 

➢ Insert Separator then name it 

Flash 3, inlet (Feed F3), Vapour 

Outlet (Vap F3) & Liquid Outlet 

(Crude). 

➢ Set parameter dP 60 psi. 

➢ Insert Compressor with name 

Comp 1, inlet (Vap F3), Outlet 

(Outlet C1) & Energy (Q 

Comp1). 

➢ Set parameter, 72% Adiabatic 

Eficiency & fill P Outlet C1 80 

psia.  



➢ Insert Mixer with name Mixer 3, 

inlet (Outlet C1 dan Vap F2) & 

Outlet ketik Feed Cool1. 

➢ Insert Cooler with name Cool 1, 

inlet (Feed Cool1), Energy (Q 

Cool1), & Outlet (Feed F4).  

➢ Set parameter dP 5 psi & 100 F 

on Feed F4  

➢ Insert Separator with name 

Flash 4, inlet (Feed F4), Vapour 

Outlet (Vap F4) & Liquid Outlet 

(Liq F4). 

➢ Insert Compressor with name 

Comp 2, inlet (Vap F4), Energy 

(Q Comp2) & Outlet (Outlet 

C2). 

➢ Set parameter Adiabatic 

Eficiency 72% then input Outlet 

C2 260 psia.  



➢ Insert Mixer with name Mixer 4, 

inlet (Outlet C2 & Vap F1) & 

Outlet (Feed Cool2). 

➢ Insert Cooler with name Cool 2, 

inlet (Feed Cool2), Energy (Q 

Cool2) & Outlet (Feed F5). 

➢ Set parameter dP 5 psi & 100 F 

on Tout.  

➢ Insert Separator with name 

Flash 5, inlet (Feed F5), Vapour 

Outlet (Vap F5) & Liquid Outlet 

(Liq F5) 

➢ Insert Compressor with name 

Comp 3, inlet (Vap F5), Energy 

(Q Comp3) & Outlet (Feed 

Cool3) 

➢ Set parameter with adiabatic 

efisiensi 72% & input pressure 

Feed Cool3 750 psia. 



➢ Insert Cooler with name Cool 3, 

inlet (Feed Cool3), Energy (Q 

Cool3) & Outlet (Feed F6). 

➢ Set parameter dP 5 psi 100 oF on 

Tout. 

➢ Insert Separator with name 

Flash 6, inlet (Feed F6), Vapour 

Outlet (Gas) & Liquid Outlet 

(Liq F6) 

➢ Insert Mixer with name Mixer 5, 

inlet (Liq F5 dan Liq F6) & 

Outlet (Liq Return). 

➢ Insert 2 Stream with name 

Recycle 1 & Recycle 2. Then, 

Define 1st with Liq Return & 

2nd define with Liq F4.  

➢ Input Recycle 1 in inlet Mixer 1 

& Recyle 2 in inlet Mixer 2.  



➢ Insert Recycle with name RCY 

1, inlet (Liq Return) & Outlet 

(Recyle 1) 

➢ Insert Recyle again with name 

RCY 2, inlet (Liq F4) & Outlet 

(Recycle 2). 

➢ Flowsheet already complete. 

Then, use Adjust to produce 

crude 15 psia 100 oF. But, 

before show table, we show 

variabel crude vapor pressure in 

Utility Stream Crude. 

➢ Click Stream Crude then click 

Attachments & Utilities 

➢ Click Create & pick Cold 

Properties then close. 

➢ Input Adjust & set: 

Adjusted Variabel: 



Object  : Outlet Heater 

Temperature 

Target Variabel: 

Object Filter  : Utilities 

Variabel  : Cold Properties 

True VP at 100 F 

Target Value : 15 psia 

Tolerance : 1e-2 

Step Size : 18 

Minimum : 0 

Maximum : 1000 F 

Iterasi  : 1000 

➢ Then we can see on the stream 

Crude that True Vapor Pressure 

100 F = 14.92 psia and Flow 

Rate Gas 7110 lbmole/hr. 

Flowrate Crude 62800 

barrel/day. 

 



Result: 

 
 

 

 

 

 

 

 



5. Natural Gas Pipeline 

Determine & evaluate 

requirement data such as Flow 

Rates, Pipeline Conditions, 

Compression Requirements, 

etc.  

Data, as below: 



 



 

Step: 

➢ Insert component and use PR as 

FP then Enter Simulation. 

➢ Insert blue stream with name 

(Gas Feed) & fill the 

composition & condition.  



➢ Insert Pipe Segment then inlet 

(Gas Feed), Outlet (Pipeline 

Out) & Energy (Q Losses). 

➢ Click Rating & click Append 

Segment 4x. Then, input the 

data and pick Rating also 

Segment HTC in Heat Transfer. 

➢ Input Ambient Temp. & HTC. 

Then, close. 

➢ Insert Tee then inlet (Pipeline 

Out), fill Outlet (To Valve) & 

(+Fuel) 

➢ Set Parameter & input Fuel (0.1) 

➢ Insert Valve, inlet (To Valve) & 

Outlet (Compressor Feed) then 

10 psi for dP .  

➢ Insert compressor, fill inlet 

(Compressor Feed), Energy (Q 



Comp) & Outlet (Compressor 

Out)  

➢ Set parameter, fill with 78.5% 

on Adiabatic Effisiency then 

Pressure Outlet 2200 psia. 

➢ Insert Spreadsheet & Add 

import with: 

Cell (A3), Object (Fuel), 

Variabel Description (Molar 

Flow) & A4, Q Comp & Heat 

Flow.  

 

 

 

 

 

 

 



➢ Set Spreadsheet then fill it as 

below 

 
 

➢ Fill in C7 = C6-A4. Close. 

➢ Insert Adjust then set: 

Adjusted Variabel: 



Object     : Tee 

Variabel : Flow Ratio (Flow 

Ratio 2) 

Target Variabel: 

Object     : SpreadhseetC7 

Variabel  : C7 

Target Value = 0 

Toleransi  : 1e-3 

Step Size : 0.2 

Minimum : 0 

Maximum : 1 

Iterasi  : 1000 

 

 

 

 

 

 

 



 

➢ Show table and see the result 

 


